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CMX Software HD 3.6 User Manual 

 

Central Management Software (CMX Software HD 3.6) is a total solution for managing LILIN’s 

network products including IP cameras and DVRs.  CMX Software HD 3.6 contains (1) network 

video recording software, (2) eMap Manager, (3) Database Manager, (4) Web Server, and (5) 

Remote DVR playback and file download. 

 

Major features including unlimited H.264/JPEG IP cameras and DVR’s cameras recording, remote 

DVR video playback and file download, and camera groupings with user authentication are 

integrated within one system application.   

 

One important feature of eMap is the central management system for live monitoring, alarm 

snapshot management, and map management.  IP devices installed at different locations can be 

represented and managed by using maps.   

 

Circular recording, schedule recording, individual HDD recording configurable, and individual 

camera recording configurable provide the flexibilities in managing recording storages.  CMX 

Software HD 3.6 is designated for hybrid solution for IP camera, video server, IP Fast Dome, and 

DVRs.  It provides total solutions for digital surveillance.  Major features are: 

 

CMX Software HD 3.6 Main Features 

1. Record and manage unlimited channels of H.264/JPEG HD IP cameras or DVR’s 

cameras. 

2. Scheduling, continuous, and motion detection recording supported 

3. eMap live video with alarm snapshots 

4. Integrated alarm management for alarm output 

5. Web server for live video 

6. iPhone and Android phones support 

7. Retail and transportation business solutions 

8. Device grouping and recall 

9. IP Fast Dome control 

10. Export recorded video to AVI file format 

11. Easy-to-use calendar and time selections for video playback 

12. User access levels configurable for groupings and features 

13. Complete operational event logs 

14. Two-way audio and audio recording 

15. Digital zoom, device ePTZ and ROI supported 

16. Dynamically video channels swapping with mouse drag-and-drop 

 

Copyrights 

Merit LILIN Enterprise Co. Ltd. holds exclusive ownership of the software and all intellectual 

property rights embodied therein, including copyrights and valuable trade secrets incorporated 

in the software's design and coding methodology.  The software is protected by international 

treaty.  This agreement provides you with only a limited use license, and does not grant you 

any intellectual property rights in the software. 

 

Adobe and Acrobat Reader are either registered trademarks or trademarks of Adobe Systems 

Incorporated in the United States and/or other countries. 
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Windows, Windows 2000, Windows XP, Windows Vista, and Windows 7 are registered 

trademark of Microsoft Corporation in the United States and other countries 

 

How to Register CMX Software HD 3.6  

To register CMX Software HD 3.6, please click on Register button from Login dialog box or About 

button to register the software.  To get unlocking key, please visit 

http://www.ddnsipcam.com/cgi-bin/cmxReg.cgi.  Please type all the necessary information.  

The unlocking will be sent to your email account. 

 

After receiving the unlocking key, please click on Register button.  Enter mail address and 

unlocking key to get full access of CMX Software HD 3.6. 

 

 

General Notations 

The terms of IP-based devices or products used in this document refer to H.264 HD/JPEG IP 

Fast Domes, Video Servers, or IP Cameras.  The terms of DVR devices/products refer to DVR 

3 and 5 series. 

http://www.ddnsipcam.com/cgi-bin/cmxReg.cgi
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Before Using CMX Software HD 3.6 

CMX Software HD 3.6 contains video recording.  CMX Software HD 3.6 supports multiple hard 

disk drives recording.  If overwritten setting is enabled, the oldest recorded video clips get 

deleted first.  If you want logical partitions in your hard disk drive, please setup at least 20 GB 

for each drive.  To setup hard disk setting, please click on “System Setting” button.   

 

 

Select recording hard drives for CMX Software HD 3.6 recording.  To enable HDD overwritten 

option, please check this option. 

 

 

Furthermore, each logical HDD drive should contain at least 10% empty space for storing video 

data.  CMX Software HD 3.6 deletes the oldest files first until it reaches 90% of the logical drive, 

and it proceeds to the next logical hard disk drive for recording. 

   

On-line User Manual 

CMX Software HD 3.6 adopts Acrobat Reader for its on-line manual by clicking on “Windows-> 

Merit LILIN CMX HD 3.6->User Manual”.  You must install Acrobat Reader before opening the 

on-line manual. 

 

Uninstall CMX HD 3.6 

To uninstall CMX HD 3.6, please select Start->Program Files->Merit LILIN CMX HD 

3.6->Uninstall.  A user might want to export the database.  Re-import the database after new 

installation.  Please see Database Manager for detail. 

Using CMX Software HD 3.6 on Windows Vista and Windows 7 platforms 

When you install CMX Software HD 3.6 on Windows Vista and Windows 7 platforms, please go 

to control panel->User Account Control Setting and low the setting to Default.  This can make 

sure that CMX can login automatically when watch dog performs system reboot. 
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CPU Usage 

To limited CMX Software HD 3.6 CPU usage, a user can click on CPU usage button to limit CPU 

usage at certain percentage.  
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Chapter 1.  Using CMX Software HD 3.6 

To access CMX Software HD 3.6, follow these steps: 

1) Click on CMX Software HD 3.6 via Start->Program Files->Merit LILIN CMX Software 

HD 3.6->CMX Software HD 3.6. 

2) Click on CMX Software HD 3.6 on desktop. 

 

To login CMX Software HD 3.6, please follow these steps: 

Step 1.  Select a user from User name dropdown list. 

Step 2.  Type the password or leave it blank if you are first time to use this software. 

Step 3.  Click on OK button. 

 

 

 

Chapter 1-1.  System Settings 

System settings contain HDD settings, device settings, and grouping settings.  Please finish 

System Setting before operating CMX Software HD 3.6. 

 

 

 

Note: The default passwords for all users are empty. 
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 Auto run this application when system starts:  

CMX Software HD 3.6 auto-run when Windows starts 

 Auto sequence after reboot:  

Perform grouping sequence after system reboot. 

 Full mode after reboot:  

Perform full screen mode after system reboot. 
 Original video resolution at full screen mode:  

Use original resolution at single channel view mode.  Do not scale original video. 

 Auto login when system starts:  

Bypass login when system starts. 

 Default grouping:  

Set default grouping at start-up. 

 Auto minimized when system starts:  

CMX runs in the background when system starts. 

 Limit max CPU usage: 

 Limit the CPU usage at certain rate. 

 Default grouping:  

Set default grouping. 

 Default window division:  

Set default window division at start-up. 

 

 To enable circular recording, please check HDD Overwritten option.  To select HDDs for 

recording, please select HDD(s) for recording in HDD Information list box. 

 System reboot:  

enable the system to reboot every day at certain time. 

 CMX ID: 

 The CMX ID controlled by PIH-931D keyboard 

  Language:  

To choose language setting, please select your language from Language combo box. 

 

Chapter 1-2.  Add a New Device 

 

To add a particular device, please first select the channel and click on “Property” button for 

adding a new device.  The “Camera Settings” dialog box shows up.  Please type at least, 

IP/DNS address, port number, username, and password for connecting the live video of the 

device.  You can also click on “Find Device” and selection one device from the IPScan tool.  

Click on “Detect” button for detecting the device type. 
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To edit Camera Setting dialog box, please right mouse click on a channel and select Camera 

Properties menu item.  

   

1.   Name— camera name which is displayed on top of live video channel 

2.   Location—indicating the location of the camera installed. 

3.   Frame rate—frame rate for the device 

4.   ONVIF--frame rate and video quality settings based on ONVIF protocol. 

5.   Device type—device type selection box, RTSP is for H.264 D1 or H.264 HD IP 

cameras. 

6.   Enable recording—enable or disable recording for the device 

7.   Auto Import DVR--auto import DVR cameras into CMX automatically 

8.   Low Bitrate Recording Mode --record one frame per second. 

9.   IP/DNS (required)—the IP address of the device 

10. HTTP Port number—the HTTP port number of the device 

11. Video Port number—DVR’s video port number/IP camera’s RTSP port number 

12. Username—the username which is allowed to login the device 

13. Password—the password for the username 

14. Image size—the source video size of the device 

15. Camera/485 ID—IP Fast Dome RS-485 ID. 

16. Low Bitrate Client and Server Connection—Connect in between CMX in low bitrate 

mode. 

17. Synchronize Time with PC—Synchronize time with the remote PC.   
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If the above settings are done, you can click on Connect button to test if the device is properly  

For default username and password information, please see appendix for detail. 

 

Chapter 1-3.  Device Type 

There are few device type drivers for connecting streaming: 

 

 RTSP--Connect an IP camera with RTSP streaming protocol. 

 DVR-JPEG--Connect a DVR by MJPEG protocol. 

 DVR-H264--Connect a DVR by H.264 protocol. 

 CMX-JPEG--Connect a CMX by MJPG protocol. 

 Low Bitrate IP Camera--Connect an IP camera by low bitrate protocol. 

 Low Bitrate DVR Camera--Connect an IP camera by low bitrate protocol. 

 Looping Camera--For demonstration purpose, you can choose Looping Camera at 

Device Type selection box for duplicate video channel without physically connecting to 

an IP camera or a DVR’s camera.  It can reduce bandwidth for the network video. 

 

    

Chapter 1-4.  ONVIF Setting 

To use RTSP streaming, please first setup ONVIF protocol.  The detail setting of ONVIF is 

described as below: 

  

 Profile: a user can select different streaming profile such as H.264 720P or JPEG 720P. 

 Protocol: streaming protocol such as RTP/UDP, RTP/TCP, or RTP/TCP/HTTP. 

 Quality: compression quality 

 Brightness: brightness setting of the video 

 Saturation: saturation setting of the video 

 Contrast: contrast setting of the video 

 Sharpness: sharpness setting of the video 

 Frame rate: change frame rate setting of the IP camera. 

Note: 1. RS-485 camera ID (1 to 128) must match the ID setting of the IP Fast Dome.  The 

software may not control PTZ movement if the ID setting is incorrect.   
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 Bit Rate: bit rate setting of the video 

 

 

 

 

 

Chapter 1-5.  IPScan Utility 

To find out the network devices, IPScan utility can scan through all IP address within LAN. 

 

A user can select a device item in IPScan and click on Close button to setup the device.  All the 

device information such as IP address and port number get automatically carried over CMX 

Software HD 3.6.  Click on Connect button in the device dialog box which can test the 

connection between the PC and the device.   

 

You can also manually add devices information of IP Fast Dome/IP camera/video server/DVR  

 

Chapter 1-6.  Alarm Output Management 

For motion and remote motion alarm detection management, the alarm output feature allows 

Note: IPScan can only work under LAN environment, not Internet environment. 

Note: ONVIF setting can only be supported by LILIN’s ONVIF camera. 
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various reactions after receiving an alarm.  The alarm output includes: 

 

  (1) Play sound--Trigger PC alarm sound after receiving an alarm.  

  (2) Send email--Send an JPEG email snapshot after receiving an alarm.  

  (3) PTZ Preset Go--Recalling a PTZ preset after receiving an alarm.  

  (4) Signal Digital Output--Triggering a DO output of an IP camera after receiving  

   an alarm.    

  (5) Alarm Full Screen--Triggering full screen mode after receiving an alarm. 

 

Please select the alarm output from the selection list to enable the option. 

 

 

Chapter 1-7.  Enable Alarm Input 

CMX Software HD 3.6 can be managed to receive remote IP camera motion detection signal 

and CMX motion detection signal.  Depend on IP camera models, CMX Software HD 3.6 can 

also receive alarm signals including face detection alarm, tampering detection alarm, audio 

alarm, and dry-contact digital input alarm.  These alarm signals can be received by CMX and 

eMap manager.  Please enable "Enable Alarm Input (DI)" option for receiving alarms.
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Chapter 2.  Recording Settings 

CMX Software HD 3.6 is configured as continuous recording after an IP camera is connected.  

To change recording configuration, please follow the following selections. 

 

Chapter 2-1.  Schedule Recording Settings 

CMX Software HD 3.6 can schedule recording based on “Always”, “No Record”, and “Motion  

recording for a particular hour.   

 

 

To enable recording for a particular hour, please click on the week control and set the recording 

option for the hour.  Please also specify the recording type by selecting one of the recording 

types. 

 

To enable recording schedule for all hours, please click on Apply button for “Apply All Schedule”. 

 

To apply the recording settings for all cameras, please click on Apply button for “Apply Schedule 

to All Channels” 

 

Chapter 2-2.  Motion Detection Recording 

To enable motion detection recording, please click on camera “Property” button to enable 

“Camera Settings” dialog box.  Once the IP camera is configured properly, please click on 

“Video” button to test the video streaming.    
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Please click on “Motion” button to setup motion detection.  There are up to four motion areas 

available for a user to configure.  Perform mouse-dragging on the video area to define a motion 

area.  Perform right-mouse click can clear a area or clear all areas.  To change motion 

detection sensitivity, please click on the scroll bar for adjust.   

 

 

 

At live monitoring mode, if a motion detection is triggered, the camera window shows “little man” 

to indicate a motion detection event.  
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Chapter 2-3.  Recording at System Startup 

After the restart of CMX Software HD 3.6, CMX Software HD 3.6 starts recording automatically.  

There is no need to restart recording service.  If a schedule is set, CMX Software HD 3.6 

records video based on the schedule at startup.    

 

Chapter 2-4.  Estimated Recording Days  

After system installation, to estimate approximate recording days, a user can click on System 

setting button to enable system dialog box.  Click on “Record time” tab.  Estimated recording 

day and time information gets shown on the dialog box. 

 

 

Chapter 2-5.  Network Storage 

For recording over network storage such as iSCSI or NAS storage, a user can configure CMX 

Software HD 3.6 to record the video to the network storage, if the network storage supports 

“Network Neighborhood” protocol. 
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To do so, please first select a drive at “Add Network Drive” list.  Select network storage by click 

on “Mapped Drive of CMX PC” button.  Once the network storage is selected, click on Apply 

button.  At the last, please check the newly added network storage from Drive Number for 

enabling the storage.  CMX records based on the selected drivers at circular recording basis. 
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Chapter 3.  Grouping Settings 

A user may want to manage camera or DVR groupings based on their geographic locations or 

their functions.  The video of the grouping devices can be recalled easily later on.  To setup 

groupings, please click on the Grouping button and follow the followings steps.   

 

 

1. Select left IP Cam/DVR grouping and select right grouping item.  Click on Right button 

to create a grouping. 

2. Click on Up or Down button to change the sequence in Grouping tree view.  

3. Click on Apply button for the grouping settings. 

 

 

 

Once the groupings are set, a user can switch to different grouping view quickly.  

 

Chapter 3-1.  Grouping Name 

A user can assign a name for a grouping.  To assign grouping name, please right click on a 
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grouping, or select on a grouping and click on Property button for its name.  Type the grouping 

name in Grouping dialog box.  

 

Chapter 3-2.  Grouping’s Devices 

Once a grouping is set, please select the device of the grouping.  Right click on the 

pre-assigned grouping device item.  Select on the device item and perform right mouse click 

for assigning Property.  

  

Chapter 3-3.  Grouping Authentication 

To assign a grouping access right, please right click on a grouping and select Property menu 

item.  It shows a Grouping Access dialog box.  The default setting of a grouping allows every 

user to access.  To disable access right, please uncheck a user access right.  Grouping 

access right also applies to web server.  Only groupings assigned to a user can be seen by the 

user after login to the web server. 

 

 

Chapter 3-4.  Recall a Grouping 

To recall a grouping, click on grouping drop down list.   
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Chapter 3-5.  Grouping Sequence 

In grouping tab, please specify Sequence Time.  In live monitoring mode, please click on SEQ 

button to perform Sequence Display feature. 

 

 

Chapter 3-6.  Main Grouping 

Main Grouping refers to CMX Software HD 3.6’s main screen which contains 36 

windows-division screen.  To add a device for the main grouping, please follow the steps: 

 

(1) Select Main Grouping in grouping dropdown list.   

(2) Right mouse click on one of the cameras. 

(3) Select Camera Properties to assign the camera properties.   

 

Alternatively, a user can add devices into Main Grouping at System Settings->Device Settings.  

Device Settings allows a user to manage up to 36 channels of IP cameras, video servers 

(PVS-1020 and PIH-1000S), and H.264 HD IP’ cameras.   

 

 

 

Chapter 3.7.  Window-divisions 

Currently, CMX Software HD 3.6 supports four types of window-division including maximized 

window (each view), 4-window-division, 16-window-division, and 36- window-division.  To see 

the maximized camera window, you can select particular camera window and click on Each 

View button.  You can also double-click on the live video for the maximized window.  To see 4-, 
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16-, and 36-window-division, click on the window-division buttons. 

 

 

 

 

 

 

 

 

Chapter 3.8.  Dynamic Video Channel Editing 

If a user wants to change the arrangement of a camera channel, the user can drag a camera 

and drop to another video channel.  This operation swaps these two cameras’ positions 

dynamically in software.  There is no need to re-assign all the IP settings, if the user later 

changes his/her mind for the camera’s display position after installation. 

 

  

Chapter 3.9.  Digital Zoom 

To perform digital zoom, please first drag on the window for digital.  Once the channel is in 

digital zoom mode, please select the green area for other region. 

 

Drag-n-drop 

 Each 

v

i

e

w 

16-window-division 

w 

4-window-division 

w 

36-window-division 

w 
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To perform digital zoom in playback, please follow above procedure. 

 

 

  Chapter 3.10.  Two-way Audio 

To perform two-way audio, please first select a particular channel for listening to the audio of the 

channel.  Click on Speaker icon to enable audio feature.  To change volume, please change 

volume bar.   

 

To speak to remote site, please click MIC On button.   

  

To enable audio monitoring, please double click on a channel in full screen mode for audio 

monitoring.   
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Chapter 4.  CMX Software HD 3.6 Video Playback 

CMX Software HD 3.6 can perform video playback task for all IP-based products including 

H.264 HD IP Cameras, full D1 IP Cameras, IP Fast Domes, Video Servers, LAN Cameras, and 

DVRs.  To perform video playback on various IP devices, follow the following sections:     

 

Chapter 4-1.  Playback 

To perform playback operation, you have to select a camera channel or a DVR.  By clicking on 

playback button, the playback dialog box shows up.   

 

 

Based on a DVR device or an IP camera device, each device of the playback operation is 

described in the following sections: 

 

 

Chapter 4-2.  Playback for a IP Camera within the Main Grouping 

For the main grouping, the video can be recorded at a local PC.  To retrieve stored video clips, 

playback operation can be performed based on date and time specified.  Please follow the 

following steps to play video clips on the PC: 
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Step 1.  Click on the date on the calendar control. 

Step 2.  Specify starting time and ending time. 

Step 3.  Click Search button to search the video clips. 

 

 

 

 

 

 

Once a video clip is playing, click on Stop, Play, Pause, <<, >>, and snapshot buttons for the 

video clip.  A user can also click on the time-bar for video playback.   

 

Chapter 4-3.  Remote DVR Playback 

For playback on a remote DVR, please first perform right-mouse click on a DVR channel.  

Select “DVR Remote Playback” menu item for DVR video playback. 

 

 

The DVR Playback dialog box shows up.  Specify date and time information in the dialog box 

for remote DVR playback. 

Alarm Recording Continuous Recording 
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Chapter 4-4.  Remote DVR File Download 

To download remote DVR’s files, please first perform right-mouse click on a DVR’s channel.  

Select “DVR File Backup” menu item.  A DVR File Backup dialog box shows up.  Specify date, 

time information, and click on Search button.  It can list all the files of the DVR.  For 

downloading the files, please click on Save Folder button and click on Download button for 

downloading the files into a specific folder. 

 

Chapter 4-5.  AVI File Exporting & Play From a File 

 Exporting AVI with OSD 

To export an AVI file for main grouping device, please perform playback operation for the device.  

Once the video clips have been located, specify the file name and click on Save Now button for 

the AVI file. 
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Exporting AVI without OSD 

For direct exporting H.264 AVI file without OSD time stamp, this operation performs fast than 

rendering OSD.      

 

CMX Software HD 3.6 video clips are stored in a hard drive’s Video folder followed by a GUID 

folder.  The GUID folder is a 32-digit hex folder.  CMX Software HD 3.6’s video clips are stored 

as in the folder under year, month, day, hour, and minute.  To retrieve a particular a file, please 

locate the file by the button of “Play from a File”.  

 

 

Chapter 4-6.  Snapshot 

For IP-based devices, you may want to capture a particular video into a picture.  You can click 

on the Snapshot button.  The picture is exported to a JPEG file format.  For DVR devices, 

please perform right-mouse-click and select “Save As JPEG” menu item. 

 

Chapter 4-7.  Alarm Event Playback 

To playback based on motion detection events, please click on the alarm radio button at the 

Playback dialog box.  Click on Search button to list all the motion detection events.  Click on a 

motion event can play associated video. 
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Chapter 5.  User Settings 

User setting allows add a user, delete a user, change password for a user, and assign feature 

accessed by a user.     

 

To add, delete, and modify a particular user, click on User button in NVR tool box.  

 

 

The User Setting dialog box shows up. 

 

 

Chapter 5-1.  Add a User 

To add a user, click on a particular user in the user list and click Add button.  Add User window 

shows up.  To add user, specify user name, password, and confirm password.  Please also 

specify the user level and click on OK button. 

 

 

Chapter 5-2.  Modify an Existing User 

To modify an existing user, click on a particular user in the user list and click Property button.  

To modify the user, specify user name, password, and confirm password.   
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Chapter 5-3.  Delete a User 

To delete a user, please select the user in user setting window and click on OK button. 

 

Chapter 5-4.  User Authorization 

Features of CMX Software can be assigned for a user.  To enable a feature for the user, please 

first click on Property button.   The User Property dialog box shows up.  Click on the check 

box for the user in Access Level list item. 

  

 

 

Chapter 5-5.  Alarm Email Notifications 

For sending alarm email notifications, please configure the email setting in the user.  After 

finishing email setting, please configure Alarm Output Management at Camera Settings. 
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Chapter 6.  PTZ Control Panel 

In order to perform PTZ movements, you have to select a particular live channel which contains 

an IP Fast Dome.  Once an IP Fast dome is selected, you can control the movements using PC 

keyboard and/or PTZ control Panel. 

 

         

Chapter 6-1.  Preset Point Settings 

 

To setup preset points, please invoke Presets dialog box.  Follow the following steps: 

 

Step 1.  Select preset point dropdown list. 

Step 2.  Type the time field. 

Step 3.  Type the speed field. 

Step 4.  Click up, down, left, or right to move the IP Fast Dome to specific position. 

Step 5.  Click Apply button to set the position. 

 

PTZ control 

IRIS control 

Focus control 

Speed control 
Zoom control 

control 

Auto pan control 

Preset settings 

Preset points 
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Chapter 6-2.  CMX Software HD 3.6 Status Panel 

CMX Software HD 3.6 status panel is described as following chart. 

      

Chapter 6-3.  Control PTZ via PIH-931D Keyboard 

To use PIH-931D keyboard for CMX, please follow the following steps.  First, please add a 

RS-232<->RS-485 convertor for connecting PIH-931D keyboard and a CMX PC.  

 

 
Chapter 6-3-1.  DVR Control Mode 

Press the SHIFT button and the DVR button to set the keyboard to DVR control mode. 

Recording percentage of HDD  

System date 

System time 

Sequence mode 

PTZ indicator 

RS-232<->RS-485 Convertor 

MIC status 

CPU usage 

User status 
Speaker status 
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+  

 
 

To control a CMX, please first enter the DVR ID (CMX ID) follow by the ENT button. 

 
+  + 

 

To recall a grouping, please type 1 + MON and following by grouping ID and the PRESET 

button. 

 
+ 

 
+  +  

 

Chapter 6-3-2.  Window-division 

To change window-division, please first control a CMX and type the following buttons. 

 

 
16-division 

 
8-division 36-division CMX ID + DVR + ENT 

 
9-division 

 
4-division   

 

To recall 36-window-division, please type CMX ID followed by DVR and ENT buttons.  The 

operation is same controlling a CMX. 

 

Chapter 6-3-3.  Recall a Camera 

For recalling a camera, please select camera number and follow by CAM button. 

 

Example: Call camera #8 

 

 

 

 

Zoom in 

 

Zoom out 

 
Tilt up 

 
Tilt down 

 

Pan left 
 

Pan right 

  
Zoom in 

 
Zoom out 

  
Focus near 

 
Focus far 

 +  +  
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IRIS small 

 
IRIS large 

 
Auto Pan   

 

Chapter 6-4.  IP Camera ePTZ or ROI Feature 

For some IP cameras, they provide ePTZ or ROI feature.  A user can still use the keyboard 

controller for ePTZ or ROI feature via CMX Software HD 3.6.  

 

Chapter 6-5.  Keyboard Playback 

Please press SHIFT and DVR buttons for playback a CMX.  To select date and time, please 

use Joystick to control the mouse for selection.  

 
+ 

 

To control the CMX, please type CMX ID, DVR button and ENT button. 

 
+  + 

 

For operating playback features, please follow the following: 

 

Pause: Press PAUSE button during playing video can pause the video in pause mode.   

  

Play: Replay the video after Pause, Fast Forward, or Fast Rewind. 

   

Fast Forward: Fast Forward the playback video. 

  

Fast rewind: Fast Rewind the playback video.  

 

Stop: Stop the playback video and return to playback menu. 
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Chapter 7.  eMap Manager 

eMap is an application which can manage devices such as IP camera, IP Fast Dome, and DVRs 

on multiple maps.  With eMap Manager, user can easily locate a particular device on a map.     

 

 

Chapter 7-1.  Before Accessing eMap Manager 

Before accessing eMap, terms and screen layout are described in the following section: 

 

 

 

 

 

 

 

 

 

 

  

Find Device Panel 

To find a device, please click on Find Device Panel button or View->Device menu.  Click on the 

device in Find Device Panel.   

 

Alarm Snapshot Camera with 

Camera View 

Multiple Live 

Video 

Map 

Representation 

Alarm Snapshot Device Tree 
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PTZ Control Panel 

To control PTZ device, please double click on a PTZ device.  Perform PTZ feature on the PTZ 

control panel. 

 

 

 

Chapter 7-2.  Tool Bar 

The buttons from left to right are described as follows: 

 

 

New map: Create a new map. 

 

 

Delete map: Delete an existing map. 

 

 

Export map as: Export existing for later use. 

 

 

Map properties: Set map properties. 

 

 
Device properties: Set device properties 

 

Refresh: Refresh eMap map list and device information.  
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Drag device mode: Drag a device on a map for its position. 

 

 

Camera view control: Clockwise and counter-clockwise rotate a camera view. 

 

 

Device list panel: Switch to Device panel. 

 

 

Find device panel: Switch to Find Device panel 

 

 

PTZ control panel: Switch to PTZ control panel. 

 

 
eMap edit mode: for editing a map, deleting a map, and setup a device on map. 

 
eMap control mode: for PTZ control and live monitoring mode 

 

Chapter 7-3.  eMap Alarm Options 

  

 

 

Chapter 7-3-1.  Setup a Map 

To setup a device map, click on File->New Map or New button at Map list.  A file opening dialog 

box gets displayed.  Please select the JPEG map file representing the installation site.  Type 

both map name and location information. 
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To delete a map, please first select the map in Map List and click on File->Delete Map or click on 

Delete button.   

 

To access property of the page, click on Property button. 

 

 

 

Chapter 7-4.  Setup a Device on a Map 

To setup devices on a map, drag-and-drop a device from Device List to its associated map.  

The device item shows checked if the device is setup on the map.  

 

 

Chapter 7-4-1.  Delete a Device on a Map 

To delete the device on the map, follow the following steps: 

  

1. Select on the device. 

2. Right click on the device. 

3. Select “Device Delete” menu item. 

 

Or, uncheck the check box of the device item. 
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Chapter 7-4-2.  Arrange a Device 

 

To arrange the device position on the map, click on Drag Mode tool or menu item to enable 

device drag mode.  Use mouse point drag the device to the destination area.     

 

 

Chapter 7-4-3.  Device Property 

To show a Device Property, select “Device Property” menu item on the menu.  A Device 

Property dialog box shows up.  Device name and device text color can be changed for 

distinguishing its background image.   

 

 

 

Chapter 7-5.  Find a Device on eMap 

DVR, DVR’s camera, or IP-based devices can be setup on different maps.  It is very difficult for 

a user to find the live video of a particular device.  To find a device on eMap instantly, a user 

can click on Find Device Panel button/View->Find menu item.  List of all devices in Find Device 

Panel can be found on a map instantly.  The user can click on the device that eMap can 

automatically switch to the map and show the device and its live video. 
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Chapter 7-6.  Camera View Control 

A camera view control can indicate a camera’s viewing angle.  To setup camera view control, 

please click on the clockwise/counter-clockwise camera view control to rotate camera viewing 

angle. 
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Chapter 8.  Web Server 

Each CMX has one web server for displaying live video.  To enable the service, please specify 

the port number of the PC’s IP address.   

 

 

Once this is done, the user can click on the HTTP Link and launch Internet browser to see the 

video.   

 

 

Chapter 8-1.  Login Web Server 

To login CMX web server, please provide the username and password for the service.  The live 

video is grouped based on grouping as in CMX Software HD 3.6.  Once a grouping is managed, 

the grouping can be assigned for its access right of a user.  Please see grouping section for 

detail.   
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Chapter 9. Database Manager 

Database Manager allows a user to perform operational report printing, event report printing, 

database importing, database exporting, and database repairing.   

 

 

To perform above features, please see the following: 

 

 

 

 

 

Chapter 9-1.  User Operational Report 

 

For showing all logon logs, please click on “User Log Report” menu item.  To print out the 

report, please click on “Print/Print Preview” menu item.  

 

Chapter 9-2.  Event Report 

  

For showing all alarm event logs, please click on “Event Report” menu item.  To print out the 

report, please click on “Print/Print Preview” menu item. 
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Chapter 9-3.  Database Maintenance 

 

Database maintenance is constantly required.  To perform database maintenance, please click 

on Tool->Compact DB or click on Compact DB tool button. 

 

Chapter 9-4.  Import Database 

 

Database configuration can be imported from a XML configuration file.  To import database, 

please click on Import Database button.   

 

Chapter 9-5.  Export Database 

 

Database configuration can be export to a XML file for later use.  To perform exporting, please 

click on Export Database button. 
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Chapter 10.  Retail and Distribution Business Solutions 

CMX Software HD 3.6 is able to connect to Point of Sale (POS) terminals.  POS transaction 

data can be captured by CMX Software HD 3.6.  POS transaction data can be displayed on live 

video and playback video.  CMX Software HD 3.6 also provides smart transaction search for 

associated video clips.  To perform these features, please follow the steps below: 

 

Chapter 10-1.  POS Connection Basis for Retail Business 

CMX Software HD 3.6 basically listens to the ASCII/COM output of a POS system via RS-232.  

Please check POS’s display output or printer output for ASCII data of your POS system.  

Please consult your POS provider for more detail.    

 

 

 

Basically, please connect RX/TX of the RS-232 of a POS register/terminal to CMX PC.  Please 

see wiring diagram below: 

 

To connect more than one POS terminals, add more RS-232/COM port into the CMX PC. 
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Chapter 10-2.  Test POS Communication with a PC 

After the POS connects to the CMX PC, please use Hyper Terminal or other RS-232 capturing 

application to test and to verify POS data that can be captured in the CMX PC.   

 

Chapter 10-3.  Link POS with a Channel 

To link a POS to a camera, please click on “Property” button and “POS” button.  The POS 

Setting dialog box shows up.   

 

 

 

 

In POS Setting dialog box, please specify the following information for capturing POS 

transactions. 

(1) Device: POS register number. 

(2) COM Port: The mapped COM port number for the POS terminal. 

(3) Print on Video File: Record POS transaction into video file. 
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(4) Print on Playback: Display POS transaction during playback. 

(5) Print on POS Live: Display POS transaction at live video. 

(6) Text Alignment: Alignment of POS transaction. 

 

 

Once above information is setup correctly, CMX Software HD 3.6 starts to capture and to display 

POS transactions on live video.  

 

 

 

Chapter 10-4.  Playback with POS Transactions 

During playback, the recorded POS transactions get shown on the video and displayed on the list 

box.  Click on a POS transaction.  The video clip is played associated with the time of the POS 

transaction.     

Note: For demo purpose, please press F3 to show simulated POS transitions. 
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Chapter 10-5.  Search POS Transactions 

Too search a particular search conditions such as an amount, a product item, subtotal, and total, 

a user can set the search condition for associated time stamp.  Click on the item in the listbox.  

It can play the video of the transaction.  

 

Chapter 10-6.  Scanner Connection Basis for Transportation Business 

For transportation business, a barcode scanner and a keyboard are widely used.  The barcode 

scanner for scanning barcode is connected to a PC via the PS/2 connector of the CMX PC.  

The barcode scanner acts as a keyboard.  In CMX Software HD 3.6, the scanner connection 

only accepts 0 to 9 for keyboard scanner or the barcode scanner.   
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To use barcode scanner as transaction device, connect barcode scanner into PS/2 connector.  

In “Camera Settings” dialog box, enable “barcode scanner” option.  For one PC, there is only 

one video channel that can be set for the barcode scanner. 

 

For search barcode transactions and playback on the barcode transaction, please see “Playback 

with POS Transactions” and “Search POS Transactions” for detail. 
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Chapter 11.  Mobile Phone Support 

Chapter 11-1.  iPhone and iPad support 

Please use your iPhone and select AppStore for download Live Cams Pro application developed 

by Eggman Technologies. 

 

Execute Live Cams Pro application.  Please click on “Add Camera” button on your phone while 

using Live Cams Pro.  Task bar gets prompted as below: 

 

 

 

Please select one of the following cameras or DVRs type： 

LILIN NVR: NVR104/108/116/CMX driver. 

 

Please provide the following information: 

1. Name: IP Camera or DVR’s camera name 

2. Host or IP: IP address or DNS address 

3. Port: Port number 

4. Provide username and password information.  For IP camera, the default username and 

password are “admin” and “pass”.  For DVR, the default username and password are “admin” 

and “1111”. 

 

Once above information is entered, please click “Save” button.  You are able to see live video of 

the IP camera or DVR’s camera.  
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Chapter 11-2.  Android Support 

Please use your Android phone and select Android Market for download Live Cam Viewer 

application developed by Robert Chou. 

 

  

Execute Live Cam Viewer application.  Please click on Setup button on your phone while using 

Live Cam Viewer.  Task bar gets prompted as below: 

 

 

Please click on Manage Cameras button.  A list of camera names shows on the screen.  

Please select one of the cameras and click on Edit button.  

 

 

 “Add/Edit IP Camera” dialog box gets prompted for editing of an IP camera or a DVR. 
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In “Add/Edit IP Camera” dialog box, please enter the following information: 

1. Name: Name of the IP camera or DVR’s camera 

2. Category: Please select Merit LILIN. 

3. Type: Select device type, Merit LILIN D1/Merit LILIN HD/Merit LILIN DVR. 

4. IP Address: Please type IP address, for example http://59.124.49.36:60005 where 60005 is 

the port number. 

5. Provide username and password information.  For IP camera, the default username and 

password are “admin” and “pass”.  For DVR, the default username and password are “admin” 

and “1111”. 

 

Once above information is entered, please click “Save” button.  You are able to see live video of 

the IP camera or DVR’s camera.  

 

http://59.124.49.36:60005/
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Chapter 12.  Trouble Shooting 

Chapter 12-1.  What should I do if I experience video flickering in CMX 

If you experience video flickering at CMX of the PC’s graphic card, please follow the instruction 

for solving the problem.         

 

Step 1: Please go to “Control Panel->System and Maintenance->System Properties” at 

Windows 7. 

 

 

Step 2: Click on “Performance Setting” button and select “Adjust for best performance” option.  

It can solve the flickering problem. 
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APPENDIX 

System Requirement 

OS:    Windows XP Home, Windows Vista Home, SP3 required, Windows 7 Home 

CPU:    Minimum Intel Duo CPU 2.0 GHz or above 

RAM:  4 GB DRAM or above 

HDD Size:   At least 250 GB for recording storage 

Network:     Gigabit network  

 

Product Supported 

 H.264 D1 IP Camera:  IPS203/IPS212, IPS025/030/035, IPS125/130/135, IPR454X 

 H.264 HD IP Camera:  IPR31ESX, IPD112ESX, IPG012ES, IPR414ES, IPR614ES, 

IPR712S, IPD012 

 H.264 1.3 MP IP Camera: IPR31MX, IPR712M,  

 Full HD IP Camera Series: IPR733, IPR434, IPR742, IPR742, IPR722S, IPD320ESX,   

IPG1022, IPG1052, IPD2220 

 Video Server:    VS012 

 DVR/NVR:  PDR-400IP, DVR304, DVR308, DVR316, DVR508, DVR516, 

NVR104 

 

Username and password 

Default username and password for various devices are described as in the table: 

 

Device Admin Admin pass. Oper Oper pass. Guest Guest pass. 

IP Cameras admin pass None None guest guest 

DVR/NVR admin 1111 None None guest 2222 

CMX Software admin EMPTY operator EMPTY guest EMPTY 

 

Benchmark Environment: 

PC network card—Gigabit network card 

Gigabit hub * 1 
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H.264 benchmark table 

 Intel Core i7-2630QM 

2.00GHz 

RAM: 8 GB DDR III 

CPU model: Intel i7 Quad-Core  

2.93GHZ 

RAM: 2 GB DDR III 

CPU model: Intel T5750,  

2GHZ DuoCore 

RAM: 3 GB DDR II 677 

 OS: Windows 7, 64 bit OS: Windows 7, 64 bit, SP1 OS:  Windows XP SP1 

 H.264 (1920X1080) 

30 FPS 

H.264 (720X480) 

30 FPS 

H.264 (1280X768)  

15 FPS 

H.264 (720X480) 

 30 FPS 

H.264 (1280X768)  

15FPS 

Channel CPU Usage CPU Usage CPU Usage CPU Usage CPU Usage 

2 25% 1% 3% 22% 15% 

4 30% 2% 3% 41% 34% 

6 40% 3% 9% 55% 37% 

8 50% 5% 19% 63% 55% 

10 65% 9% 21% 80% 64% 

12 75% 9% 26% 87% 84% 

14 Overloading 9% 28% 94% 100% 

16 Overloading 9% 35% 100% Overloading 

18 Overloading 9% 50% Overloading Overloading 

20 Overloading 11% 77% Overloading Overloading 

22 Overloading 12% 84% Overloading Overloading 

24 Overloading 17% 85% Overloading Overloading 

26 Overloading 20% 85% Overloading Overloading 

28 Overloading 24% 100% Overloading Overloading 

30 Overloading 25% Overloading Overloading Overloading 

32 Overloading 31% Overloading Overloading Overloading 

34 Overloading 40% Overloading Overloading Overloading 

36 Overloading 48% Overloading Overloading Overloading 
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CMX 3.6 HD Software Specification 

Recording Schedule / Motion detection / Manual recording 

   Live  Current 36 channels display/720 channels in total 

   Speed Up to 1080P 30 FPS and ROI recording supported 

   Resolution 1080P / HD 1280 * 768 / D1 720 * 480 / VGA: 640 * 384 / CIF 320 *240 / CIF: 320 * 192  

   Schedule 7 day * 24 hrs time table, recording mode configurable 

   Alarm recording Face detection, audio detection, tampering, motion, DI alarm detection 

   Audio recording Yes 

Playback Time search, event search, date search, POS smart search 

   Speed FR: 2x, 4x, 8x, 16X 32X / FF: 2x, 4x, 8x, 16X, 32X 

   Compression H.264 / JPEG 

Video Input Unlimited Merit LILIN IP cameras / DVR connections 

   Camera name 20 characters  

   Channel editing Mouse drag-n-drop 

   Digital zoom Yes, ePTZ supported 

   Grouping User grouping authentication assignable for eMap, and CMX Software HD 3.6 

Multiplexer Sequence  

   Split screen 4, 9, 16, 36 

Alarm  

   Alarm management PC sound, redirect IP camera DO, eMail snapshots, redirect a PTZ preset recall 

   Event Various alarm log, video loss, stop recording, schedule, logon, operation log 

   Digital output Controllable 

Accessories  

   P/T/Z protocol LILIN PTZ controllable via HTTP 

   Audio PCM/G.711, two-way audio, audio recording 

   POS/barcode Scan RS-232/PS/2 

   Keyboard PIH-931D keyboard controllable via RS-485 for PTZ, ePTZ, and ROI features  

eMap  

   eMap live monitoring One channel for IP camera/multi-channel for DVR 

   eMap snapshot Yes 

   PTZ control Yes 

DB Manager  

    Database  Database configuration import, export, report, and maintenance 

Remote Manager Remote device configuration 

    Device status monitoring Schedule remote device status monitoring 

Backup  

 DVR remote backup, AVI conversion and JPEG snapshots 

Management  

    Access log Complete access log in database manager 

    User management User authentication: three level: admin, operator, and guest, features configurable 

    Recording calculator Yes, dynamically calculating available recording days 

Network  

    Web interface Live web interface 

    Mobile support iPhone and Android 

    Protocols ARP / TCP/IP / HTTP / SMTP / DNS / PPPoE 

    IPScan Supported, easy-to-setup for IP address 

Other  

    DST Daylight saving time by Windows OS 

    OS Windows 7 Home, Windows Vista Home, and Windows XP Home 

    Language 
English, Chinese, Spanish, French, Italian, Japanese, Russian, Portuguese, Simplified 

Chinese, and German 

    CPU requirement Minimum Intel Duo CPU 2.0 GHz or above 

    RAM requirement 4GB memory 
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